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Instructions for the Use of the Requirements Sheet - 2003 Version

Enable the Content:

1. Open Microsoft Excel 2003.
2. 'ck on Tools and then, click on Macros from the drop-down list.
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3. Click on Security.

4. Set the Security to Medium.
[Securiey, = = = == = 21

Trusted Publishers |

wery High. Only macros installed in trusted locations will be allovwed
to run. all other signed and unsigned macros are disabled.

High. ©nly signed macros From krusted sources will be allowed to
run. Unsigned macros are automatically disabled.

ol

Medium. ¥ou can choose whether or not to run pokentially unsafe
macros.

(]

Lows {not recommended). ¥ou are not protected From potentially
unsafe macros, Use this setting only if you have wirus scannin
software instalied, or you hawe checked the safety of all documents
you open.

(=13 I Cancel I

5. Open the Requirements-2003.xls Excel file.
6. Click on Enable Macros.
]

"E:\Requirements-Sheet-2003, xls" contains macros,

Macros mawv conkain viruses, It is usually safe to disable macros, but if the
macros are legitimate, wou might lose some Functionality.

Disable Macros Enable Macros More Info
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Run The Macro to Create the Mandatory, Mandatory Scored, and
Additional Scored Spreadsheets:

. Click to

1. Click on Tools. te th

2. Click on the button called Create Spreadsheets. create the
spreadsheets

A B C D 3 F
Requirements Worksheet for RFPs and RFQCs

2
C T )
4 Proposal Factors % Split (100% if working on an RFQC):

Total Number of
s Questions: Cost Factors % Split (0% if working on an RFQC):

Total Number of Assist with

Attachments in Evaluation

6 RFP/RFQC: Proposal Factors Points:
Cost Factors Points:

Allow Artchts

< . + j ints with Attachment File
Questions per Major Categories 5 z F A e

9 Information?

o [ [12 1= T [ 1 12 [ [ 1= 1 [
iR el N e

25
26

A

Clicking this button creates three spreadsheets:
e Mandatory Spreadsheet
e Mandatory Scored Spreadsheet
e Additional Scored Spreadsheet

You attach these spreadsheets to your RFP Template (SPD-SP016 State Entity
eRFP Template) when you post it.

3. Once the Macro has created the spreadsheets, a message similar to this one
displays indicating the location where the three spreadsheets are saved (the

spreadsheets are saved on the same location where the Requirements-Sheet-
2003 is located).
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A B C D

E F

&
T
=

1 Requirements Worksheet for RFPs and R
2
3 Solicitation Name: . . . Create
4 Proposal Factors % Split (100% if working on an RFQC): Soreadsheets
Total Number of _
5 Questions: Cost Factors % Split (0% if working on an RFQC):
Total Number of Assist with
Attachments in Evaluation
6 RFP/RFQC: Proposal Factors Points: Spreadsheets
7 Cost Factors Points: 1000.00
8
Question # Allow Attchts
S Workbooks Created @ mel MM:::: e
9 Information?
10 Proposal Factors The workbooks have been exported out into the Folder: P:\RFP Training|RFP Development Process|Requirements.

accepted in writing by the State Entity, and sum-e:..c
the terms and conditions of such acceptance, w
constitute 3 valid and binding contract between the

11 undersigned and the State Entity,

Mandatory

Supplier must certify his/her compliance with the
following by answering “yes™: That the supplier
guarantees and certifies that all items included in
the supplier's propesal meet or exceed anyand a
such stated eRFP specifications and requirements
except as expressly stated otherwise in the

12 supplier's proposa

Mandatery

Supplier must certify his/her compliance with the

following by answering “yes™ That the technical and|
cost proposals submitted by the supplier shall be

valid and held open for 2 period of one hundred and

w

s (120) days from the final eRFP closing date
and that the proposals may be held open for a

engthier pericd of time subject to the supplier's
onsent

4. Once you create the spreadsheets, you need to refine and protect them. Follow

the steps in the next section.
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Adding Yes/No Selections to the Mandatory Spreadsheet to Allow a
Response from the Suppliers

Once you create the spreadsheets, you need to protect them and refine
them. Follow these steps:

Mandatory Spreadsheet:

1. Access Microsoft Excel.
2. Open the Mandatory.xls spreadsheet.

Adding Yes/No selections for the Suppliers to respond:

1. To add a drop-down Yes/No selection to allow the suppliers to respond to the
Mandatory requirements, click on the cell (or one of the cells) where you
want to add the Yes/No selection. In this case, you want to click the first cell
where the suppliers provide a response to the requirement in the Response
by Offeror. Only Yes or No Answer column (row 8 and column ¢, in this
example).

Mandatory Questions

By answering "Yes,” you indicate that you meet the individual requirements in the response block provided. ONLY upload documen
there is a Yes in the “Upload Attachs with Additional Information?" column, to provide additional information about specific questio
Documents not reguested in this column will not be evaluated.

%\%’%mm

DO NOT INCLUDE ANY COST INFORMATION IN YOUR RESPONSE TO THIS WORKSHEET.

5
6
7 State Compliance
Supplier must certify his/her compliance with the following by answering "yes™ That this electronically
1 submitted proposal constitutes an offer, which when accepted in writing by the State Entity, and subject to Mo @
the terms and conditions of such acceptance, will constitute a valid and binding contract between the
8 undersigned and the State Entity
Supplier must certify his/her compliance with the following by answering "yes" That the supplier guarantee st
2 and certifies that all tems included in the supplier's proposal meet or exceed any and all such stated eRFP No
specifications and requirements except as expressly stated otherwise in the supplier's proposal.
a
Supplier must cenify his/her compliance with the following by answering “yes™ That the technical an)
3 proposals submitted by the supplier shall be valid and held open for a period of one hundred and twe SeIeCt the Ce” Where
days from the final eRFP closing date and that the proposals may be held open for a lengthier period
10 subject to the supplier's consent. YOU Want tO place the
Supplier must certify his/her compliance with the following by answernng "yes™ That the provisions o .
TN Officia) Cpslesof Grmsem—ouated 100 stmen_hay emig)aletkand will nat bes Yes/No selection
g - :

2. Once you have clicked on the cell where you want to place the Yes/No
selections, click on Data on the Excel Main Menu Bar to list the selections

available.

Revised 07/21/2011 SPD-SP059a



\:ﬂ_] FEile Wiews Insert Format Toflls | Data l;ﬂ dow  Help
: - A
i =N = We-SrE TRE N Q- - LT
ES - F Filter »
| | Subtotals. ..
1 [ valdation... ]
These guestions are Pass/Fail. To festito ol and eligible for award, you must answer all questions in thi
i#l PivotTable and PivotChart Report... " to pass.
2 Import External Data »
" List » . . . .
Any gquestions you answer w rements and results in disqualification of the proposal.
| %ML >
3
By answering “Yes,” you indi th = ] its in the resp block provided. ONLY upload documen
there is a Yes in the "Upl i1 Attache——+ to provide additi I infor about specific question:
4 D ts not req ted in this col will not be evaluated.
5 DO NOT INCLUDE ANY COST INFORMATION IN YOUR RESPONSE TO THIS WORKSHEET.
(=}
7 State Compliance
Supplier must certify his/her compliance with the following by answering "yes™ That this electronically
submitted proposal constitutes an offer, which when accepted in writing by the State Entity, and subject to
the terms and conditions of such acceptance, will constitute a valid and binding contract between the
8 undersigned and the State Entity
Supplier must certify his/her compliance with the following by answering "yes™ That the supplier guarantees
and certifies that all iterms included in the supplier's proposal meet or exceed any and all such stated eRFP
specifications and requirements except as expressly stated otherwise in the supplier's proposal.
=]
Supplier must certify his/her compliance with the following by answering "yes™ That the technical and cost
proposals submitted by the supplier shall be valid and held open for a period of one hundred and twenty (120)
days from the final eRFP closing date and that the proposals may be held open for a lengthier period of time
10 subject to the supplier's consent.

Supplier must c wering “ye That the provisions of the

ertify his/her compliance with the following by ans
= » S L0 -

Lol

and will not be &‘ b

e not be

3. Select Validation from the list of selections on the drop down menu.

View Insert Format Tools | Data Lﬂindow Help
RSG5 @9t st 10 - |B 7 U|E=E=ES %
- £ Filter »

These guestions are Pass/Fail. To

and eligible for award, you must answer all questions in thi

il PivotTable and PivotChart Report... " to pass.
2 Import External Data »
List
Any guestions you answer w - * rements and results in disqualification of the proposal.
| %ML »
3
By answering “Yes,” you indicate th = ] 1its in the resp block provided. ONLY upload documen
there is a Yes in the "Upload Anack. - to provide additi I infor about specific question:
4 Documents not req d in this col will not be evaluated.
5 DO NOT INCLUDE ANY COST INFORMATION IN YOUR RESPONSE TO THIS WORKSHEET.
g
[EZ3] State Compliance
Supplier must certify his/her compliance with the following by answering “yes™ That this electronically
submitted proposal constitutes an offer, which when accepted in writing by the State Entity, and subject to Mo
the terms and conditions of such acceptance, will constitute a valid and binding contract between the
8 undersigned and the State Entity.
Supplier must certify his/her compliance with the following by answering “yes™ That the supplier guarantees
and certifies that all iterms included in the supplier's proposal meet or exceed any and all such stated eRFP Mo
specifications and requirements except as expressly stated otherwise in the supplier's proposal.
2
Supplier must certify his/her compliance with the following by answering “yes™ That the technical and cost
proposals submitted by the supplier shall be valid and held open for a period of one hundred and twenty (120) Mo
days from the final eRFP closing date and that the proposals may be held open for a lengthier period of time
10 subject to the supplier's consent
Supplier must certify his/her compliance with the following by answering "yes™ That the provisions of the
w 1 orgia ; - not be i and will not be & ol
4. When the Validation dialog box displays, drop the list in the Allow field and
select List.
Revised 07/21/2011 SPD-SP059a



Data Yalidation x|

Setkings | Input Message | Errar Alert |

Yalidakion criteria

¥ Ignore blank

[whole number
Dmcicn=l
r Lisk

Time:
Texk length
_uskom

[T apply these changes to all ather cells with the same settings

Clear All | (0] 4 I Cancel |

5. After selecting List in the Allow field, enter Yes, No in the Source field and
click OK.

Data Yalidation x|

Settings | Input Message | Error Alert |

Yalidakion criceria

Al

IList j IV Ignare blank
Diata: V¥ In-cell dropdown
biekwesn j

Source:;

|‘1|"|E!sJ Mo :k_j

I apply these changes ko all ather cells with the same settings

Clear all | (4 I Cancel

6. At this point, the selected cell now has a selection to enter Yes or No.
Highlight the cell to copy to the rest of the cells in that column.
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Mandatory Questions

These questions are Pass/Fail. To be considered r i ible and eligible for award, you must answer all questions in this)
sectmn \m!h a "YES" to pass.

2
Any questions you answer with a "NO" will fail the technical requirements and results in disqualification of the proposal.
Al
By answering "Yes,"” you indicate that you meet the individual i ts in the resg block provided. ONLY upload doc ts i
there is a Yes in the "Upload Aﬂachs with Additional Infnrmatmn’ column, to provide additional qurmatlon about specific question:
4 ts not req 1 in this col will not be evaluated.
- DO NOT INCLUDE ANY COST INFORMATION IN YOUR RESPONSE TO THIS WORKSHEET.
<]
i State Compli
Supplier must certify his/her compliance with the following by answering "yes"™ That this electronically
1 submitted proposal constitutes an offer, which when accepted in writing by the State Entity, and subject No
the terms and conditions of such acceptance, will constitute a valid and binding contract between the
8 undersigned and the State Entity. B
»*

10

Supplier must certify his/her compliance with the following by answering "yes”™ That the supplier quarantefls | Yes
P and certifies that all items included in the supplier's proposal meet or exceed any and all such stated eRl
specifications and requirements except as expressly stated otherwise in the supplier's proposal.

Supplier must cerify hisfher compliance with the following by answering "yes” That the technical and co

3 proposals submitted by the supplier shall be valid and held open for a period of one hundred and twenty (120)
days from the final eRFP closing date and that the proposals may be held open for a lengthier period of time
subject to the supplier's consent,

2]
No
Mo (
Supplier must cerify his/her compliance with the following by answering yes That the prowsmns of the
\#.0 ial Code tio -10-20 & an, {olat M

7. To copy, select the cell you want to copy (row 8 and column ¢, in this
example). Then, click on the Copy icon or click on Edit and then, select Copy
from the drop-down list. Then, highlight the rest of the cells where the
supplier responds with a Yes or No and paste it until all appropriate cells
have the drop-down list.
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Eile | Edit
0239

Wiew Insert Format Tools Data Window Help

Undovalidation Ctrtz |1 .1 @ = - 4]l @ E'Arial -0 - B I U
Cut Chrls

Then, click on
Edit and then,
on Copy

"

s

A

th

Copy Chrl+C B

Office Clipboard. .. andato Luestio

Baste Clrk+¥ I. To be considered responsive, responsible and eligible for award, you must answer all questions in this

Paste Special... section with a "YES" to pass.

Fil »
Clear

Delete. ..

»
wer with a "NO" will fail the technical requirements and results in disqualification of the proposal.

Find... Chrl+F

v Documents not requested in this column will not be evaluated.

tate that you meet the individual requirements in the response block provided. ONLY upload documents if
Attachs with Additional Information?" column, to provide additional information about specific questions.

DO NOT INCLUDE ANY COST INFORMATION IN YOUR RESPONSE TO THIS WORKSHEET.

State Compliance

Supplier must certify his/her compliance with the following by answering "yes": That this electronically
submitted proposal constitutes an offer, which when accepted in writing by the State Entity, and subject to
the terms and conditions of such acceptance, will constitute a valid and binding contract between the
undersigned and the State Entity.

-

Mo

Supplier must cedify histher compliance with the following by answering "yes" That the supplier g
and certifies that all tems included in the supplier's proposal meet or exceed any and all such stated eRFP
specifications and requirerents except as expressly stated otherwise in the supplier's proposal.

Mo

10

Supplier must certify his/her compliance with the following by answering "yes" That the technical and cost
proposals submitted by the supplier shall be valid and held open for a period of one hundred and twenty (120)
days from the final eRFP closing date and that the proposals may be held open for a lengthier period of time
subject to the supplier's consent.

Mo

4

11 in any respect.
4.4 » wj\Mandatory i Sheetz f She /

Supplier must certify his/her compliance with the following by answering "yes" That the provisions of the

Official Code of Georgia Annotated, Sections 45-10-20 et seq. have not been violated and will not be violated

am
Click on the
cell you want

Mo

to copy

8. Then, highlight the rest of the cells where you want the Yes/No selection to
be copied and click on Edit, then on Paste to copy the original cell.

Revised 07/21/2011

SPD-SP059a




E_!'_] File | Edit | ¥iew Insert Format Tools Data ‘Window Help
N A B-9-18=-5 @ [ -10 -|B 7 U |EXNEE
CI| % Cut Chri+3
53 copy Ctri+C B c
7 State Compliance = |
hisfher compliance with the following by answering "yes"™ That this electronically
% Paste Chri+v onstitutes an offer, which when accepted in writing by the State Entity, and subject to
- = ions of such acceptance, will constitute a valid and binding contract between the
e State Entity.
Then. click on Fill * Fy hisfher compliance with the following by answering "yes"™ That the supplier guarantees
’ Clear » [ items included in the supplier's proposal meet or exceed any and all such stated eRFP T
Edit and then, Delete. equirements except as expressly stated otherwise in the supplier's proposal.
Paste 44 FEind... Ctri+F  Fy hisfher compliance with the following by answering "yes™ That the technical and cost
d by the supplier shall be valid and held open for a period of one hundred and twenty (120§ No
eRFP closing date and that the proposals may be held open for a lengthier period of time
10 I + g rLﬁefs consent.
Supplier must certify his/her compliance with the following by answering "yes"™ That the provisions of the
4 Official Code of Georgia Annotated, Sections 45-10-20 et seq. have not been violated and will not be violated MNo
11 in any respect.
12 Experience
Supplier must provide 3 references of organizations (private or public organizations) that have an approximate
building size of 12000 square feet or greater of cleaning area where similar cleaning services, as requested in
E1 this solicitation, have been performed. Compile and upload these references in one file named References-3. yes
Preceed the file name with the name of your company: For example, for a company named ABC, the name
13 of the file will be: ABCReference-3.
Supplier must provide 3 references of organizations (private or public organizations) where similar cleaning
serices were performed to prove that the supplier has been performing this type of work for a minimum of five
E2 years. Compile and upload these references in one file named References-Syears. Preceed the file name yes
with the name of your company: For example, for a company named ABC, the name of the file will be:
14 ABCReference-Syears,
Supplier must be certified in Green Seal Cleaning and provide a copy of the certificate. Upload and name the Ll
E4 file containing your certificate GreenSealCertificate. Preceed the name of the file with the name of your
company. For example, for a company named ABC, the name of the file will be: ABCGreenSealCertifical High“ght the
15
16 Customer Service cells where
Supplier must provide a list of all its customers for the last 2 years. Compile and upload this list in one fil
’NW amed Ligtofi _ Preceed the fil i urcompany: F argale for you want to

copy

9. Repeat step 8 for the rest of the cells where you want to copy.

Protecting the worksheet

Once you have setup the cells the way you need them, you are ready to
protect the worksheet. Protecting the worksheet will ensure that the
suppliers do not change the configuration or the contents of your worksheet.

1. Highlight the cells (column) where the supplier will respond Yes/No.
Then, click on the Format tab and select Cells... from the drop-down list.
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B Microsoft Excel - Mandatory.xls
B Ble Edt View [nses

=18

Type a question for help ~ _ &

R . N .
CyA I £ Lok D ﬁswp:ﬁ Select Cells i 7 T ]
Shest »
Any questions you| ) Erase Border e technical requirements and results in
5 AutoFormat e propsl
Conditional Formatting...
By answering "Yes,” Tyl e individual requirements in the response
P 1.
4
tep 1:
DO NOT INCLUDE ANY COST INFORMATION IN YOUR RESPONSE TO THIS WORKSHEET. the column where
5 the Offeror responds
Yes or No to the
Mandatory
B
7 Proximity to Work
8 1 The house must be 5 miles or less frarm wark I L~
E] 3 The house must be 10 minutes or less fram wark |
0 Size | I
1 1 The house must have at at least 4 bedroams. | I
2 3 |The house must have at least 2 | |
3 Age | I
: Style ] \
5] 1 [The house must have a two-car parage
[}
7
8
)
20
21
22
25
24
2
iz}
g
2
a2
32
33
34
5
B
7
=]
i)

[4]

I 4 » My Mandatory [ Sheetz £ Sheet3
'—"-‘M T Pyt - Microssft .

2. Click on the Protection tab. Then, ensure that the Locked field is
deselected. Then click OK.

Mumber | Alignmenkt | Fonk I Border | Patterns| Probection |

the Locked field is
deselected

| Hidden

Step 1: Click
on the

Locking cells or hiding Formulas has no effect unless the
worksheet is protectked, To protect the worksheet, choose
Protection from the Tools menu, and then choose Prokect
Sheet, & password is opkional,

I I Cancel
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3. Click on the Tools tab and select Protection... from the drop-down list.
Then, select Protect Sheet.

|3 Microsoft Excel - Mandatory.xls
B File Edt View Insert Formg

j o i v apeling... F7
. l—JC d _5 _Il ‘i Research.., Ab+Click
B11 “ #e The NoUS o, error Checking...

A

Step 1: Click on the
Tools tab

= R EEE - |

Speech »

Any questions you answer shared Workspace. .. fuirements and results in

Share Workbaok...

Track Changes »
By answering "Yes," you ind fjuirements in the response

4 Step 2: Select Erotection '| (il Protect Sheet...
Protection from the f
drop-down list __§ANY CO

Online Collabaration v |l alof Users to Edt Ranges. .
Goal Seek... 93 Pyfftect Workbook. .
Segnarios.., &3 ffetect and share Workbaok, .,

Farmula Auditing

Macra

1 The house must be 5 - Step 3 Select 1
9 &l [The house must be 10 = Protect Sheet

10 %  AutoCarrect Options. ..
1" 1 [The house must have G -
12 3 [The house must have |
13 Ontions. .. )

1 Sije

15 1 The house must have & two-car garage.

:%_Mandalﬂ‘y Sheetz £ Sheetd [l
ument - Mcrosoft .|

4. When the Protect Sheet dialog box displays, ensure that Protect
worksheet and content of locked cells, Select Locked cells, and Select
unlocked cells are selected. Then, enter a password that you will be able
to remember and click OK.

20

¥ Protect worksheet and contents of locked cells

Password to unprotect sheet:
I****

aorksheet to:

Allow all users of ¢

W select unlocked cells
[~ Format cells
[ Format columns
[ Format rows

[ Insert columns
[T Insert rows

[ Insert hyperlinks
[ Delete columns

[ Delete rows ;I

Ok I Cancel I

nter a password
that you will
remember

Revised 07/21/2011 SPD-SP059a



5. Reenter the same password. Then, click OK to protect your worksheet.

MNew
mm

2l x|

v Protect worksheet and contents of locked cells

Password to unprotect sheet:

il Confirm Password 2=l

Reenter password to proceed.

" Caution: IF wou lose or Forget the password, it cannot be

- recovered, It is advisable to keep a list of passwords and  —
their corresponding workbook and sheet names in a safe

1 place. (Remember that passwords are case-sensitive. )

(ol 4 I Cancel |

o

TN II_ Delete rows ~| wor

6. Save the Worksheet.

Preparing the Mandatory and Additional Scored Worksheets:

1. For the Mandatory Scored and the Additional Scored worksheets, ensure

that they print correctly. To do this:
a. Click on File.
b. Select Page Set Up...
c. Select Landscape.

Page Setup

| IMargins | Header/Foater | Sheet |

Orientation
= e
" Parkrait % | andscape
~
Scaling

% adjustbo;  |100 == % normal size

" Fit ko |1 E‘ pagels) wide by |1 E‘ kall

Select Landscape

Paper size: ILetter j

Print qualty: |60 dpi ~|

First page nurmber: I.D.utn

2

Prink. .. |
Frint Presview |
Options. .. |

oK I Cancel
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2. Protect the worksheets as you did with the Mandatory worksheet. To do
this repeat steps 1 through 6 as indicated in the previous section for the
Mandatory Scored and Additional Scored worksheets. Ensure that all your
worksheets are protected before you post them.

When Ready to Create the Evaluation Forms

Once you are ready to create the evaluation form (SPD-EP005 Master Technical
Evaluation Template form) to send to the Evaluation Committee for evaluation of
the RFP technical requirements, you need to obtain information (questions, and
points assigned) from the RFP requirements worksheet (form SPD-057
Requirements Sheet for RFP or Scored RFQC).

Using the Assist with The evaluation Worksheets button, located on the top
right of the SPD-057 Requirements Sheet for RFP or Scored RFQC form you just
completed. This button allows you to obtain the information you need to complete
the SPD-EP005 Master Technical Evaluation Template form.

1. Click on the button called Assist with Evaluation Spreadsheets.

A B C D E F G H J K
Requirements Worksheet for RFPs and RFQCs

Proposal Factors % Spit (100% if working on an RFQC):
Total Number of Mandator -
5 Questions: Cost Factors % Split (0% if working on an RFQC): 0% 0% S Scored
Total Number of Assist with
Attachments in Additions Evaluation
& RFP/RFQC: Proposal Factors Points: 0 Scored Spreadsheets
Cost Factors Points: 0.0

Allow Attchts
Points per with
Question Additional

Major

R L Questions per Major Categories oy Categories
AS Points

10 Proposal Factors

Click to
create the
spreadsheets

0o [ro o [ia o o [ T [ [
GRS e o n s ek
o

2. The following worksheets are saved on the same folder as the one where the

RFP/RFQC Requirements worksheet is located:

e A worksheet with the information you need to enter in the SPD-EP005
Master Technical Evaluation Template form for the Mandatory Scored
questions (questions and points assighed to each question).
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A worksheet with the information you need to enter in the SPD-EP005
Master Technical Evaluation Template form for the Additional Scored
questions (questions and points assighed to each question).

The following are sample worksheets:

e Mandatory scored and points assighed worksheet.

A B C
1 Mandatory Scored Questions and Points Assigned
2 Use the Information in this Spreadsheet to create the Evaluation Sheets
, Question A
4 |State Compliance
5 Experience
6 Services and Supplies
Describe in detail the typical cleaning services which your company performs at
4 commercial building sites with a minimum square footage of 12000. Include time 180
when it is performed, activities, cleaning tools (powered or non-powered),
7 cleaning supplies, and number of people typically used in the job.
Provide a project plan that outlines the resources, length of time, and activities
that your company will be performing at our site. Upload this project plan in a file
3 |called ProjectPlan. Preceed the name of the file with the name of your company. 150
For example, for a company named ABC, the name of the file will be: ABC-
8 ProjectPlan.
Provide a list of commercial equipment and supplies that will be used to provide
4 |this services to the state. Upload a file named EquipmentandSupplies. Preceed 100
the name of the file with the name of your company. For example, for a company
9 named ABC, the name of the file will be: ABC-EquipmentandSupplies.
10 Customer Services
. Provide a description of the procedures that your company follows to resolve 40
11 customer issues related to performance.
E Provide a description of the procedures that your company follows to resolve 20
12 customer issues related to resources.
5 Provide a description of the procedures that your company follows to resolve i
13 customer issues related to equipment.
. |Provide a description of the procedures that your company follows to resolve =
14 customer issues related to supplies.
wricd . £
e Additional Scored questions (questions and points assigned to each
question.
A B c D E F G H I 3 4
1 Additional Scored Qu and Points Assigned | 5
2 Information in this Spreadsheet to create the Evaluation Sheets i\
b
3 &
4 State Compliance
5 Experience
Provide a description of the training that is provided to the cleaning staff; )
5 including activities, length, monitoring, on-the-job activities and supervision, etc.; 40 ﬂ_}
to ensure that the staff is capable and qualified to perform the work outlined in c>
6 this solicitation. 5
7 Services and Supplies
Describe enviromentally friendly services and or supplies that can be used for this 50 5
8 site and outline the benefits they provide to the state.
9 Customer Services ¢
s Describe a situation where a customer was disappointed in the service provided, 55 [
10 and how you responded, resulting in a positive outcome.
1
12
13 0
14 &L
15 P
16 '
18 /
19
20
21
22
23 £
2 >
o IPZ N R D S S P mr‘\\w"" Vaarm N VN P
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You use these worksheets to create the Master Technical Evaluation
Template form by either entering the information (or copying it to) onto
the evaluation form.
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